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1.Vigtigt

Denne elektroniske brugervejledning er beregnet
til alle, der bruger Philips-skaermen. Tag den tid du
behgver for at lase vejledningen, inden du bruger

skeermen. Den indeholder vigtige oplysninger om
bemarkninger angdende brugen af din skeerm.

Philips garanti deekker under forudsatning af, at
produktet behandles korrekt og anvendes til det
tilsigtede formal i overensstemmelse med dens
betjeningsvejledning, og ved forevisning af den
originale faktura eller kvittering med angivelse af
kebsdatoen, forhandlerens navn samt model og
produktionsnummer for produktet.

1.1 Sikkerhedsforanstaltninger og vedligeholdelse

) Advarsler

Anvendelse af kontrolelementer, justeringer eller
fremgangsmader, der ikke er beskrevet i denne
dokumentation, kan resultere i elektrisk stad,
elektriske ulykker og/eller mekaniske ulykker:
Lees og felg disse vejledninger; nar du tilslutter og
anvender din computerskaerm:

Betjening:

* Hold skaermen veek fra direkte sollys og vaek
fra breendeovne og andre varmekilder:

* Fjern alt, der kan risikere at falde i
ventilationshullerne eller forhindre korrekt
afkeling af skeermens elektronik.

*  Bloker ikke ventilationshullerne pa kabinettet.

* Ved placering af skaermen skal du sikre dig,
at det er let at komme til stremstikket og
stikkontakten.

*  Huvis der slukkes for skaermen ved at fierne

stremkablet eller jeevnstremsledningen, skal du

vente 6 sekunder, for du setter stremkablet
eller jevnstramsledningen til igen for at opna
normal betjening.

Brug altid et godkendt stremkabel, der

er leveret af Philips. Hvis du mangler dit
stremkabel, skal du kontakte dit lokale
servicecenter. (Se Informationscenter for
kundepleje)

Udseet ikke skeermen for kraftige vibrationer
eller sted under anvendelse.

SI& ikke pa skeermen, og tab den ikke under
brug eller transport.

Vedligeholdelse:

Som en beskyttelse af skeermen skal du undga
at trykke kraftigt pa LCD-panelet. Nar du
flytter din skeerm, sd tag fat om rammen for at
lzfte den; laft ikke skeermen ved at sztte din
hand eller fingre pa LCD-skaermen.

Tag stikket ud fra skaermen, hvis du ikke skal
bruge den i en leengere periode.

Tag stikket ud at kontakten til skeermen, hvis
du skal renggre den med en let fugtet klud.
Skeermen kan terres af med en ter kiud,

nar der er slukket for strgmmen. Under alle
omsteendigheder, ma der ikke bruges organiske
opl@sningsmidler til renggring af din skaerm.
For at undga risiko for elektrisk stad eller
permant beskadigelse af anleegget, sa ma du
ikke udseette skaermen for stev, regn, vand eller
miliger med hej fugtighed.

Huvis din skaam bliver vad, skal den tgrres af
med en ter klud sa hurtigt som muligt.

Hvis der kommer fremmed substans eller vand
ind i skeermen, s sluk straks for strammen og
tag stikker ud. Fjern derefter den fremmede
substans eller vandet, og send skaermen til
servicecenteret.

Skaermen ma ikke bruges eller opbevares pa
steder; hvor den udsattes for varme, direkte
sollys eller ekstrem kulde.

For at opretholde den bedste ydelse af din



skeerm og for langvarig brug, sa brug skaermen
et sted, der er indenfor felgende temperatur-
og fugtighedsomrade.
o Temperatur: 0-40°C 32-95°F
o Fugtighed: 20-80% RH

*  VIGTIGT: Sgrg altid for at aktivere en
pauseskaerm, der bevaeger sig, ndr skermen
efterlades uden at blive anvendt. Du skal altid
bruge en pauseskarm eller et andet program,
der opdaterer skaermen regelmaessigt, hvis
du viser statisk materiale i leengere perioder.
Uafbrudt visning af stille eller statiske billeder
over en lengere periode kan fordrsage, at det
“breendes fast” pa skaermen, dvs. de sakaldte
"“spogelsesbilleder” pa din skaerm.
"Fastbreending” og "spegelsesbilleder" er
velkendte faenomener inden for LCD-
skaermteknologien. “Fastbraending” og
“"spagelsesbilleder” forsvinder oftest gradvist
efter en vis periode, efter skaermen er slukket.

) Advarsel

Imidlertid forsvinder alvorligere tilfeelde af
“fastbreending” og “‘spagelsesbilleder” ikke og kan
ej heller fiernes ved reparation. Ovennavnte
skader er ikke dakket af garantien.

Service
* Kabinettet ma kun abnes af kvalificeret
servicepersonale.

* Hvis der er behov for et dokument til
reparation eller integration, sa kontakt
dit lokale servicecenter: (Se kapitel om
"Kundeinformationscenter")

* For oplysninger om transport, se "Tekniske
specifikationer".

+ Efterlad ikke din skaerm i en bil/bagagerum
under direkte sollys.

& Bemzrkning

Kontakt en servicetekniker, hvis skeermen ikke
fungerer korrekt, eller hvis du er usikker pa, hvad
du skal gare, nar betjeningsinstruktionerne, der er
givet i denne manual, er fulgt.

1.2 Notationsbeskrivelser

Felgende underafsnit beskriver de
notationsmaessige konventioner, der benyttes i
dette dokument.

Bemaerkninger, forsigtighedsregler og advarsler

| hele denne vejledning kan tekstblokke veere
ledsaget af et ikon og std med fed eller kursiv
skrift. Disse blokke indeholder bemazerkninger og
punkter; hvor der skal udvises forsigtighed, eller
advarsler: De anvendes som falger:

€ Bemzrkning

Dette ikon angiver vigtige oplysninger og
tips, hvormed du kan gere bedre brug af
computersystemet.

0 Forsigtig

Dette ikon angiver oplysninger om, hvordan du
undgar risiko for skader pa hardwaren eller tab af
data.

) Advarsel

Dette ikon angiver risiko for personskader og
hvordan dette undgas.

Visse advarsler kan optreede i andre formater og
er eventuelt ikke ledsaget af et ikon. | sddanne
tilfelde er den givne udformning af advarslen
lovmeaessigt obligatorisk.



1.3 Bortskaffelse af produkt og emballage

Waste Electrical and Electronic Equipment-
WEEE

This marking on the product or on its packaging
illustrates that, under European Directive 2002/96/
EC governing used electrical and electronic
appliances, this product may not be disposed

of with normal household waste.You are
responsible for disposal of this equipment through
a designated waste electrical and electronic
equipment collection. To determine the locations
for dropping off such waste electrical and
electronic, contact your local government office,
the waste disposal organization that serves your
household or the store at which you purchased
the product.

Your new monitor contains materials that can be
recycled and reused. Specialized companies can
recycle your product to increase the amount of
reusable materials and to minimize the amount to
be disposed of.

All redundant packing material has been omitted.
We have done our utmost to make the packaging
easily separable into mono materials.

Please find out about the local regulations on how
to dispose of your old monitor and packing from
your sales representative.

Recycling Information for Customers

There is currently a system of recycling up and
running in the European countries, such as The
Netherlands, Belgium, Norway, Sweden and
Denmark.

In Asia Pacific, Taiwan, the products can be taken
back by Environment Protection Administration
(EPA) to follow the IT product recycling
management process, detail can be found in web
site www.epa.gov.tw

The monitor contains parts that could cause
damage to the nature environment. Therefore, it is
vital that the monitor is recycled at the end of its
life cycle.

For help and service, please contact Consumers
Information Center or F1rst Choice Contact
Information Center in each country.



2. Opsatning af skeerm

2.1 Installation

El Emballagens indhold

226C2/226CL2
@ =

ACIDC adapter VGA signal cable DVI cable (optional)

& Note

Use only the AC/DC adapter model
LITEON-PA-1041-0/ FSP-FSPO40-DGAA1

E Installation af stander

226C2/226CL2

1. Anbring skeermen med forsiden vendt nedad
pa en jeevn overflade, og veer forsigtig med ikke
at ridse eller beskadige skaermen.

2. Fastger skermens stander til fodsgjlen, og
fastger derefter foden.

E Tilslutning til PC

PHILIPS

Tilslutning til pc

1.

Indgang for DC-strgm
VGA-indgang

DVI-D input (tilgaengelig i udvalgte
modeller)

Kensington anti-tyverisikring

Tilslut elledningen ordentligt pa bagsiden
af skarmen.

Sluk for computeren og tag netledningen
ud af stikket.

Slut skeermens signalkabel til videostikket
bag pa computeren.

Saet computerens og skaermens
netledninger til et stik i neerheden.

Taend for computeren og skeermen. Hvis
skaermen viser et billede, er installationen
gennemfert.

2.2 Brug af skaerm

El Produktbeskrivelse set forfra

PHILIPS
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@ =/oc Til dbning af OSD menuen/OK

@ /< Til brug af turbofunktionen/ Returnere
til foregaende OSD niveau
® O Tilat sl strgmmen til skeermen til og fra
@ ©/a il @endring af signal-input kilde/
Til indstilling af OSD menuen
@ @/v Smartimage: Der kan veelges blandt seks

tilstande: Office (Kontor), Photo (Billede),
Movie (Film), Game (Spil), Economy
(@konomi), Off(Slukket)/To adjust the OSD

menu(teendt/Til indstilling af OSD menuen).

E1 Beskrivelse af OSD-displayet

Hvad er OSD (On-Screen Display)?

Visning pa skaermen [On-Screen Display (OSD)]
er en funktion pa alle Philips LCD-skaerme.

Den satter en slutbruger i stand til at justere
skeermindstilling eller veelge skaermens funktioner
direkte via et instruktionsvindue direkte pa
skaermen. Et brugervenligt skeermvisningsinterface
vises som nedenfor:

PHILIPS

Monitor Setup

AUTO Auto

226CL2 SN:0123456789
© Exit @ OK

Grundlzggende og enkle anvisninger til
kontrolknapperne

Pa OSD-skaermen, der er vist ovenfor, kan brugere
trykke pd w a-knapperne pd skaeermens frontkant
for at bevaege cursoren, OK for at bekrafte valget
eller for at aendre.

OSD-menuen

Nedenstaende er en generel oversigt over

strukturen i OSD-displayet. Du kan anvende den
som opslag, nar du senere skal orientere dig i de
forskellige justeringer:

Main menu Sub menu
— Auto
VGA
— Input [
DVI (available for selective models)
— Picture Format  -4:3. wide screen
— Brightness  -0~100
— Picture [ Contrast -0~100
— SmartResponse -On,Off
— SmartConstrast -On, Off
— Gamma 1.8,20,22,24,26
[ Color Temp-5000K, 6500K, 7500K, 8200K, 9300K, 11500K
— Color [ sRGB
— User Define -Red Green Blue
— Language — English, Espafiol, Frangais, Deutsch, ltaliano, Portugués,
Pycckui, {F‘,]MHW
— Horizontal ~ -0~100
— Vertical -0~100
— OSD Settings
— Transparency -Off, 1,2,3,4
— OSD Time Out -5, 10, 20, 30, 60
— H.Position -0~100
[ V.Position -0~100
— Phase -0~100
— Setup — Clock -0~100
— Resolution Notification ~ -On, Off
— Reset -Yes, No

—— Information

El Meddelelse om oplgsning

Denne skarm er designet til optimal ydelse ved
dens naturlige oplasning: 1920x1080@60Hz.
Nar skeermen keres pa en anden oplasning,

ses fglgende advarsel pa skeermen: De bedste
resultater opnas med 1920x1080@60Hz.
Advarslen vedrgrende den naturlige oplasning
kan deaktiveres under Installation i OSD
(skeermmenuen).



B3 Fysisk funktion

Vip 3. Produktinformation

3.1 Smart-billede

El Hvad er dette?

Smart-billede er forvalgte indstillinger, der
optimerer skarmen i henhold til indholdet, og
som realtid dynamisk indstiller lysstyrke, kontrast,
farve og skarphed. Uanset om du arbejder
226C2/226CL2 med tekstprogrammer, ser billeder eller ser
video, sa giver Philips Smartimage den optimale
skaermydelse.

2.3 Fjernelse af foden E1 Hvorfor behgver jeg det?

226C2/226CL2 Du gnsker en skeerm, som giver det bedste billede
for alle typer indhold. For at @ge skaeerm-oplevelsen,

1. Anbring skeermens forside pé en sikker indstiller Smartlmage-softwaret dynamisk lysstyrke,

overflade for at lgsne skruerne fra foden. kontrast, farve og skarphed i realtid.

El Hvordan virker det?

Smart-billede er en eksklusiv, farende Philips-
teknologi, som analyserer indholdet pa skeermen.
Ud fra det valgte scenarie forbedrer Smartlmage
dynamisk billeders og videoers kontrast,
farvemaethed og skarphed for at forbedre det
viste billede - alt i realtid og blot med et tryk pa
en knap.

2.Skrue fodsgijlens skrue af og treek foden vaek
fra skaermen.




I Hvordan aktiveres Smart-billede?

1. Tryk pd B for at starte Smart-billede pa
skaermen;

2. Fortszt med at trykke pa B for at skifte
mellem Office (Kontor), Photo (Foto), Movie
(Film), Game (Spil), Economy (@konomi) og
Off (Fra).

3. Smart-billede ses pa skeermen i fem sekunder;
men du kan ogsa trykke pa OK for at
bekrafte.

4. Nar Smart-billede er aktiveret, deaktiveres
sRGB systemet automatisk. For at bruge sRGB
skal du deaktivere Smart-billede med B foran
pa skarmen.

Udover at bruge [@p til at rulle ned med, kan du
ogsa trykke pa w A for at valge og derefter trykke
pa OK for at bekreefte valget og derefter igen
lukke Smart-billede OSD.

Der kan veelges mellem seks tilstande: Office
(Kontor), Photo (Foto), Movie (Film), Game (Spil),
Economy (@konomi) og Off (Fra).

Office (Kontor): Forbedrer teksten og
deemper lysstyrken for at @ge laesbarheden
og nedszette anstrengelsen af gjnene. Denne
tilstand @ger afgerende laesbarheden og
produktiviteten, nar der arbejdes med
regneark, PDF filer; skannede artikler og andre
generelle kontorprogrammer.

Photo (Foto): Denne profil kombinerer
farvemathed og dynamisk kontrast og
skarphed for at vise billeder og lignende
overordentlig klart og i levende farver - alt
uden synlige fejl i det indskannede billede og
blegnede farver.

Movie (Film): Viser hver detalje i videoernes
merkere omrader med gget luminans,

dyb farvemaethed, dynamisk kontrast

og barberbladsagtig skarphed og uden
farveudvaskning i de lysere omrader og opnar
pa denne made dynamiske, naturlige veerdier
med henblik pa den ultimative videovisning
Game (Spil): Aktivér overdrive-kredslgbet for
at fa den bedste reaktionstid, reducere skeeve
kanter for genstande, der bevaeger sig hurtigt
pa skeermen, forbedre kontrastforholdet for
lys og marke. Denne profil giver spillere den
bedste oplevelse af spil.



*  Economy (@konomi): Med denne profil
indstilles lysstyrke og kontrast, ligesom
baggrundslys fintunes for at opna det rette
billede til hverdagens kontorprogrammer.
Nedsat stremforbrug.

» Off (Fra): Ingen optimering med Smart-billede

3.2 Smart-kontrast

El Hvad er dette?

*  Unik teknologi, der dynamisk analyserer det
viste indhold og automatisk optimerer LCD
skaermens kontrastforhold til maksimal visuel
klarhed. Den gger baggrundsbelysningen og
giver et klarere, friskere og lysere billede eller
deemper baggrundsbelysningen med henblik pa
en tydelig visning af billeder pd merk baggrund.

El Hvorfor behgver jeg det?

Du gnsker den allerbedste visuelle klarhed

og visning ved enhver type indhold. Smart-
kontrast styrer dynamisk kontrast og indstiller
baggrundslyset, sa det giver klare, friske og lyse
spil- og videobilleder og viser tydelig, leesbar tekst
ved kontorarbejde.Ved at nedsatte skaermens
stremforbrug, sparer du energiomkostninger og
forleenger skeermens levetid.

El Hvordan virker det?

Nar du aktiverer SmartContrast, analyseres

det viste indhold i realtid for at indstille farver

og baggrundslysets intensitet. Denne funktion
forbedrer dynamisk kontrasten og giver saledes en
bedre underholdningsoplevelse, nar du ser videoer
eller spiller spil.

3.3 Smart-farvemathed

El Hvad er dette?

Smart-teknologien, der styrer farvemaethed - dvs.
graden, med hvilken én skaermfave sammenblandes
med nabofarverne - giver rige og livlige billeder

sa du kan opleve bedre underholdning, nar du ser
videoer.

E1 Hvorfor behover jeg det?

Du gnsker rige og livlige billeder for mere
underholdning og sjov, nar du ser billeder og
videoer.

El Hvordan virker det?

SmartSaturate kontrollerer dynamisk farvemaethed,
graden som skaermens farver sammenblandes
med nabofarverne, for at kunne gengive rige,
livlige billeder for bedre underholdning nar du

ser billeder eller videoer i skeermtilstanden Movie
(Film) eller Game (Spil). Funktionen er deaktiveret
for visning af kontorprogrammer i topkvalitet, samt
i tilstanden Economy (@konomi) for at reducere
stremforbruget.



3.4 Smart-skarphed

EJ Hvad er dette?

Smart-teknologien, som @ger skarpheden, nar du
behaver den til ultimativ billedydelse og mere
underholdning og sjov, nar du ser videoer og
billeder.

E3 Hvorfor behgver jeg det?

Du gnsker den ultimative skarphed for mere
underholdning og sjov, nar du ser billeder og
videoer.

El Hvordan virker det?

Smart-teknologien @ger skarpheden, nar du
behaver den, til ultimativ billedydelse og mere
underholdning og sjov, nar du ser videoer og
billeder i tilstanden Movie (Film) eller Game
(Spil). Funktionen er deaktiveret for visning

af kontorprogrammer i topkvalitet, samt i
tilstanden Economy (@konomi) for at reducere
stremforbruget.

3.5 Philips SmartControl Premium

Det nye SmartControl Premium-software fra
Phillips giver dig mulighed for at kontrollere
skeermen via et nemt, grafisk interface.
Komplicerede justeringer hgrer fortiden til.
Dette brugervenlige software guider dig gennem
finindstilling af oplgsning, kalibrering af farve,
justeringer af clockning/fase, RGB-hvidpunkt osv.

Udstyret med den seneste teknologi i algoritmer
for hurtig behandling og reaktion, er denne
igjinefaldende, ikon-baserede software, der ogsa er
Windows 7 parat, klar til at forbedre din oplevelse
med Philips-skeermel!

El Installation

* Folg instruktionen og fuldfer installationen.

¢ Du kan starte, ndr installationen er fuldfgrt.

* Huvis du vil begynde senere, kan du klikke
pa genvejen pa skrivebordet eller pa
veerktejslinjen.



Guide for forste start

Efter installation af SmartControl Premium
abnes guiden automatisk, nar du abner
programmet fgrste gang.

Guiden leder dig trin for trin gennem indstilling

af skaermen.

Du kan ogsa ga til Plug-in menuen for at starte

guiden pa et senere tidspunkt.
| Standard-ruden kan du indstille flere
funktioner uden guide.

10

B Start med Standard-rude:

Adjust menu (Indstillingsmenu):

*  Med "Adjust" ("Indstilling"-)menuen kan du
indstille Brightness (Lysstyrke), Contrast
(Kontrast), Focus (Fokus), Position (Position)
og Resolution (Oplzsning).

* Foretag indstillingen ved at folge
instruktionerne.

* Installationen kan annulleres med Cancel
(Annuller).



I

Farvemenu:

Med "Color" ("Farve"-)menuen kan du
indstille RGB, Black Level (Sortniveau),
White Point (Hvidpunkt), Color Calibration
(Farvekalibrering) og Smart-Billede (se
afsnittet Smart-Billede).

Foretag indstillingen ved at folge
instruktionerne.

Se nedenstaende oversigt med
undermenupunkter baseret pa dit input.
Eksempel pa Color Calibration
(Farvekalibrering)



Forst farvekalibreringsskaerm:

* "Previous" ("Foregdende"-) knap er deaktiveret,
indtil den anden farveskarm.

* "Next" ("Naste") gar til efterfelgende mal (seks
mal).

*  "Final next" ("Afsluttende Naeste) gar til File >
Presets (File > Forvalg) rude.

»  "Cancel" ("Annuller") lukker Ul og vender
tilbage til "plug in"-) siden.

Smart-billede

Smart-Billede - tillader brugeren at aendre
indstillingen for at opnd en bedre skaermindstilling
baseret pa indhold.

Nar der indstilles pa "Entertainment"
("Underholdning"), aktiveres Smart-Kontrast og
Smart-Svar.

"Show Me" ("Vis Mig") starter vejledningen i
farvekalibrering.

"Start" - starter 6-trins farvekalibrerings-
sekvensen.

"Quick View" ("Quick-visning") indlaeser for/
efter-billederne.

For at vende tilbage til "Color" ("Farve"-)
startruden, skal du klikke pa "Cancel"
("Annuller").

Aktiver farvekalibrering - der som standard
er aktiveret. Hvis markeringen er fiernet, kan
der ikke ske farvekalibrering, ligesom start- og
quick-visning knapperne er gratonede.

Der skal vare patent-oplysninger pa
kalibreringsskaermen.

12



ECO For at aktivere Theft Deterence (Anti-tyveri), skal
du klikke pa tilstanden Enable Theft Deterrence
(Aktiver Anti-tyveri), hvorefter folgende skaerm ses:

*  Der kan kun indtastes en PIN-kode pa fra fire
til ni cifre.

*  Nar PIN-koden er indtastet, leder "Accept"
("Accept"-) knappen brugeren til pop-op
dialogboksen pa fglgende side.

*  Minimum-minutter er fem. Skyderen star som
standard pa 5.

*  Kreever ikke, at skeermen forbindes til en anden
vart for at gd i tilstanden Theft Deterrence
(Anti-tyveri).

Theft Deterence (Anti-tyveri)-ruden er kun aktiv,
nar tilstanden Theft Deterence (Anti-tyveri) er
valgt i Plug Ins-rullemenuen.

Nar der er oprettet en PIN-kode, indikerer "Theft
Deterrence" ruden, at "Theft Deterrence" er
aktiveret og giver PIN-kode funktionsknap:

*  "Theft Deterrence Enabled" ("Anti-tyver
Aktiveret") ses.

* Tilstanden Disable Theft Deterrence
(Deaktiver Anti-tyveri) dbner rudeskeermen pa
naeste side.

*  PIN-kode Funktioner knappen virker kun, nar
brugeren har oprettet PIN-kode. Knappen
abner sikkert PIN-kode websted.

"Options > Preferences" ("Funktioner >
Indstillinger") - er kun aktiv, nar Preferences
(Indstillinger) er valgt i "Options" ("Funktioner"-)
rullemenuen-rullemenuen. P4 en ikke-understattet
skeerm med DDC/Ci er kun "Help" ("Hjlp") og
"Options" ("Funktioner") til radighed.

13



* "Run at Startup" ("Ker ved Startop") er
som standard afmeerket (Til). Nar den er
deaktiveret, starter SmartControl Premium
ikke ved starten og ikonet vises ikke i
systembakken. SmartControl Premium kan
kun startes fra genvejen pa skrivebordet eller
fra programfilen. Intet forvalg, indstillet til at
kere ved startop, indlaeses, nar denne boks
ikke er afmeerket (er deaktiveret).

*  Aktivér gennemsigtighedstilstand (Windows 7,
Vista, XP). Standard er 0% uigennemsigtighed.

"Options > Input" ("Funktioner > Indgang")

- er kun aktiv, nar "Input" ("Indgang") er valgt i
"Options" ("Funktioner"-)rullemenuen. Pa en ikke-
understattet skeerm med DDC/Ci er kun "Help"
("Hjeelp") og "Options" ("Funktioner") til radighed.
Alle andre faneblade i SmartControl Premium er
ikke til radighed.

*  Viser nuvarende, foretrukne indstillinger:

»  Funktionen aktiveres ved at afmarke feltet.
Afmezrkningsfeltet er en flip-flop.

e "Enable Task Tray" ("Aktiver Jobbakke")
menuen er som standard afmeerket (Til)
pa skrivebordet. Menuen Enable Context
(Aktivér kontekst) viser valgmulighederne i
SmartControl Premium for Select Preset (Valg
Forvalg) og Tune Display (Indstil Display) i
genvejmenuen ved hgjreklik pa skrivebordet.
Disabled (Deaktiveret) fierner SmartControl
Premium fra kontekst-genvejsmenuen.

* "Enable Context" ("Aktiver Indhold"-)
menuen er som standard afmeerket (Til)
pa skrivebordet. Menuen Enable Context
(Aktiver Indhold) gar, at systembakkens ikon
for SmartControl Premium vises. Et hgjreklik
pa jobbakke-ikonen viser menufunktionerne
for "Help" ("Hjeelp") og "Technical Support"
("Teknisk Statte"). Afmeerk for "Upgrade”

("Opgradering”), "About’ ("Om") og "Exit" * Vis "Source"l ("Kilde") instrluktiolnlsruden og
("Afslut"). Nar "Enable Task Tray" ("Aktiver nuv&rendg indgangskilde indstilling.
Jobbakke") menuen er deaktiveret, viser . Yed enkeltindgangsskeerme ses denne rude
jobbakke-ikonen kun EXIT (AFSLUT). ikke.
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"Options > Audio" ("Funktioner > Lyd") - er

kun aktiv, nar "Volume" ("Lydstyrke") er valgt i
"Options" ("Funktioner"-)rullemenuen.

Pa en ikke-understattet skeerm med DDC/Ci er
kun "Help" ("Hjeelp") og "Options" ("Funktioner") til
radighed.

Option > Auto Pivot (Funktion > Auto Pivot)

15

"Help > User Manual" ("Hjzelp >
Brugervejledning”) - er kun aktiv, ndr "User Manual"
("Brugervejledning") er valgt i "Help" ("Hjeelp"-)
rullemenuen. P& en ikke-understattet skeerm med
DDC/Ci er kun "Help" ("Hjeelp") og "Options"
("Funktioner") til radighed.

"Options > Version" ("Funktioner > Version") - er
kun aktiv, nar "Version" ("Version") er valgt i "Help"
("Hjeelp"-)rullemenuen. P4 en ikke-understettet
skeerm med DDC/Ci er kun "Help" ("Hjzlp") og
"Options" ("Funktioner") til radighed.



Context Sensitive (Indholdssensitiv) menu
"Context Sensitive" ("Indholdssensitiv") menuen
er som standard aktiveret. Hvis "Enable Context"
("Aktiver Indholdssensitiv') menuen er afmeerket
i "Options > Preferences" ("Funktioner >
Indstillinger") ruden, ses menuen.

g SmartControl
Select Preset +
Tune Display

Office
Photo
Movie
Games
Economy

"Context" ("Indhold") menuen har fire punkter

*  SmartControl Premium - nar valgt, ses "About"
("Om") skaermen.

*  "Select Preset" ("Velg Forvalgt") - en
hierakisk menu med gemte forvalg, der
straks kan bruges. En afkrydsniong viser
det i gjeblikket valgte forvalg. "Factory
Preset" ("Fabriksforvalg") kan ogsd hentes i
rullemenuen.

* Tune Display (Indstil Skaerm) - abner
kontrolpanelet for SmartControl Premium.

»  Smartlmage - Kontrollér aktuelle indstillinger
for Office (Kontor), Photo (Foto), Movie (Film),
Game (Spil), Economy (@konomi) og Off (Fra).

"Task Tray" ("Jobbakke"-) menu aktiveret
Menuen i systembakken kan ses ved at hgjreklikke
pa SmartControl Premium-ikonet i systembakken.
Et venstreklik starter programmet.

Jobbakken har fem punkter:

*  "Help" ("Hjeelp") - adgang til brugervejledning-
fil: Abner Brugervejledningen med standard
browservinduet.

»  "Technical Support" ("Teknisk Hjeelp") - viser
siden med teknisk hjzlp.

»  "Check for Update " ("Tjek for opdateringer")
- leder brugeren til PDI Landing og tjekker
brugerens version i forhold til den allernyeste
version.

*  "About" ("Om") - viser detaljerede
referenceoplysninger: Produktversion,
frigivelses-information og produktnavn.

*  Exit (Afslut) - Luk SmartControl Premium

Hvis du vil kere To run SmartControl Premium
igen, skal du enten vaelge SmartControl
Premium i programmenuen, dobbeltklikke pa
skrivebordet eller genstarte systemet.



"Task Tray" ("Jobbakke"-)menu deaktiveret

Nar "Task Tray" ("Jobbakke") er deaktiveret

i indstillinger-mappen, er kun valg af "EXIT"
("AFSLUT") til radighed. Hvis du helt vil fierne
SmartControl Premium fra systembakken, skal du
deaktivere "Run at Startup” ("Ker ved Startop")

i "Options > Preferences" ("Muligheder >
Indstillinger").

3.6 Philips' regler ved pixeldefekter pa
fladskaerme

Philips tilstreeber at levere produkter af den
hgjeste kvalitet.Vi anvender nogle af branchens
mest avancerede produktionsprocesser og udferer
en streng kvalitetskontrol. En gang imellem er
defekte pixler eller sub-pixler pa TFT LCD-skeerme
dog uundgdelige. Ingen producent kan garantere,
at alle paneler vil veere fri for pixeldefekter,

men Philips garanterer, at enhver skeerm med

et uacceptabelt antal defekter repareres eller
udskiftes under garantien. Dette notat forklarer de
forskellige former for pixeldefekter og definerer
de acceptable defektniveauer for hver type. For

at vaere berettiget til reparation eller udskiftning
under garantien skal antallet af pixeldefekter pa en
TFT LCD- fladskeerm overskride disse acceptable
niveauer. For eksempel ma hgjst 0,0004% af
sub-pixlerne pa en 22" XGA-skerm veere

defekte. Desuden sztter Philips endnu hejere
kvalitetsnormer for visse typer eller kombinationer
af pixeldefekter, derer mere generende end andre.
Denne pixelpolitik geelder i hele verden.

subpixel subpixel subpixel

vy
il 5

Pixler og sub-pixler

En pixel eller et billedelement er sammensat af tre
sub-pixler med primerfarverne rgd, gren og bla.
Nar mange pixler settes sammen, kan de danne et
billede. Nar alle sub-pixler i en pixel lyser;, fremstar
de farvede sub-pixler tilsammen som enkelt

hvid pixel. Hvis de alle er merke, fremstar de tre
farvede sub-pixler tilsammen som en enkelt sort
pixel. Andre kombinationer af oplyste og merke
sub-pixler fremstar som enkelte pixler i andre
farver




Forskellige typer pixeldefekter

Pixel- og sub-pixeldefekter optraeder pa skeermen
pa forskellige méader. Der er to kategorier af
pixeldefekter og flere typer sub-pixeldefekter i
hver kategori.

Defekte lyse prikker

Defekte lyse prikker fremkommer som pixels eller
underpixels, der altid lyser eller er "pa". Det vil
sige, at en lys prik er en underpixel, der fremstar
pa skeermbilledet, ndr skeermen viser et markt
menster: Der er folgende typer defekte lyse
prikker:

En teend rgd, gren eller bld sub-pixel

I C

To sammenliggende teendte sub-pixler:
- Red + Bl3 = Lilla

- Red + Grgn = Gul

- Grgn + Bla = Cyan (Lysebld)

Tre sammenliggende tendte pixler (en hvid pixel)
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& Bemarkning

En red eller bld lys prik skal veere mere end 50
procent lysere end de omkringliggende prikker,
mens en gran lys prik er 30 procent lysere end de
omkringliggende prikker:

Defekte megrke prikker .
Defekte marke prikker fremkommer som pixels
eller underpixels, der altid er mgrke eller "fra". Det
vil sige, at en lys prik er en underpixel, der fremstar
pa skeermbilledet, nar skaermen viser et markt

megnster. Der er felgende typer defekte mearke
prikker:

Textliggende pixeldefekter

Da pixel- og sub-pixeldefekter af samme type,
der ligger teet pa hinanden, kan vaere mere
igjnefaldende, specificerer Philips ogsa tolerancer
for teetliggende pixeldefekter.

I Pixeldefekttolerancer

For at veere berettiget til reparation eller
udskiftning pa grund af pixeldefekter i
garantiperioden skal et TFT LCD-panel i en Philips
fladskeerm have pixel- eller sub-pixeldefekter,
der overskrider de tolerancer, der er gengivet i
folgende tabeller.

BRIGHT DOT-DEFEKTER ACCEPTABELT NIVEAU

MODEL 226C2/226CL2
1 teendt sub-pixel 3

2 sammenliggende taendte sub-pixler 1

Tre sammenliggende tendte sub-pixler (en hvid pixel) 0
Afstand mellem to bright dot-defekter* >15mm
Samlede bright dot-defekter af alle typer 3
MODEL 226C2/226CL2
1 merk sub-pixel 5 eller ferre
2 sammenliggende mgarke sub-pixler 2 eller ferre
3 sammenliggende mgrke sub-pixler 0
Afstand mellem to black dot-defekter* >15mm
Samlede black dot-defekter af alle typer 5 eller feerre
MODEL 226C2/226CL2
Samlede bright- eller black dot-defekter af alle typer 5 eller feerre

(=) Bemarkning
1 eller 2 sammenliggende sub-pixel-defekter = 1 dot-defekt
Denne monitor er i overensstemmelse med 1SO9241-307
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4 Tekniske specifikationer

226C2/226CL2

Panel af LCD-typen TFI-LCD

Baggrundslys 226CL2(White-LED);226C2(CCFL)
Panelstgrrelse 215" W

Aspektforhold 16:9

Pixel pitch 0,248 x 0,248 mm

Lysstyrke 250 cd/m?

Reaktionstid (normal) 2 ms

Optimal oplgsning

1920x1080 @ 60 Hz

Signalinput

Synsvinkel 170° (H) /160° (V) @ C/R > 10
Billedforbedring Smartlmage

Skaermfarver 16,7 M

Vertikal opdateringshastighed 56 -76 Hz

Horisontal frekvens 30 - 83 kHz

sRGB JA

DVI-D (digital, HDCP),VGA (analog)

Inputsignal

Separat synk., synk. pa gren

Brugerfunktioner Smartlmage /v, INPUT/A, Taend/sluk, Turbo/Tilbage , Menu
(©K)
OSD sprog Engelsk, fransk, tysk, italiensk, russisk, spansk, simplificeret kinesisk

og portugisisk

Andre funktioner

kensington-Ias

"Plug & Play" kompatibilitet

Vip

Windows 7

-5/+20
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Teendt-tilstand 25W (typisk)

Energiforbrug AC AC AC

(EnergyStar 5.0 testmetode) indgangsspaending indgangsspaending indgangsspaending
ved 115VAC +/- 5VAC, | 230VAC +/- 5VAC,
100VAC +/- 5VAC, | 60Hz +/- 3Hz 50Hz +/- 3Hz
50Hz +/- 3Hz

Normal funktion (typisk) 22,53W 2241W 22,39W

Sovetilstand 0,36W 0,35W 0,36W

Fra 0,24W 0,24W 0,26W

Varmetab® AC AC AC
indgangsspaending indgangsspeending indgangsspaending
ved 115VAC +/- 5VAC, | 230VAC +/- 5VAC,
100VAC +/- 5VAC, | 60Hz +/- 3Hz 50Hz +/- 3Hz
50Hz +/- 3Hz

Normal drift 73,48BTU/hr 73,07BTU/hr 73,00BTU/hr

Sovetilstand 1,47BTU/hr 1,43BTU/hr 1,47BTU/hr

Fra 1,43BTU/hr 1,43BTU/hr 1,47BTU/hr

Teaendt-tilstand 23W(typisk)

Energiforbrug AC AC AC

(EnergyStar 5.0 testmetode) indgangsspaending indgangsspaending indgangsspaending
ved 115VAC +/- 5VAC, | 230VAC +/- 5VAC,
100VAC +/- 5VAC, | 60Hz +/- 3Hz 50Hz +/- 3Hz
50Hz +/- 3Hz

Normal funktion (typisk) 17,52W 17,68W 1741W

Sovetilstand 0,36W 0,34W 0,35W

Fra 0,24W 0,26W 0,25W

Varmetab* AC AC AC
indgangsspaending indgangsspeending indgangsspaending
ved T15VAC +/- 5VAC, | 230VAC +/- 5VAC,
100VAC +/- 5VAC, | 60Hz +/- 3Hz 50Hz +/- 3Hz
50Hz +/- 3Hz

Normal drift 75,52BTU/hr 75,48BTU/hr 73,07BTU/hr

Sovetilstand 1,47BTU/hr 1,43BTU/hr 1,71BTU/hr

Fra 1,43BTU/hr 1,43BTU/hr 1,67BTU/hr

Strgmdiode Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)

Stremforsyning

Produkt uden fod (BxHxD)

AC-adapter; 1,2V==3,33A

515 x 399 x198 mm

Produkt uden fod (BxHxD)

515 x 327 x 43 mm

Kassemal (BxHxD)

562 x 467 x 109 mm
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Produkt med fod

331 kg (226C2) / 2.96 kg (226CL2)

Produkt uden fod

316 kg (226C2) / 2.81 kg (226CL2)

Produkt med emballage

Temperaturomrade (drift)

485 kg (226C2) / 45 kg (226CL2)

0°C il 35°C

Temperaturomrade (lkke drift) | -20°C til 60°C

Farve

Myndighedernes godkendelser

Relativ fugtighed 20% til 80%
Hojde lkke drift: + 40,000 ft ( 12,192m)
Betjening: + 12,000 ft ( 3,658m)
MTBF 50.000 timer(226C2)/30.000 timer(226CL2)
[ Miiomassigeforhold ]
ROHS JA
EPEAT Selv. (www.epeat.net)
Emballage 100% genbrugelig

CB, TUV/ ISO, SEMKO, GOST, CCC, BSMI, KUCAS, UL/CUL,
FCC,ICES,SASO,TUV S-mark, Enersy star 5.0, SABS

Sort/sort

Finish

Blank/tekstur

= Bemarkning

Disse data kan @ndres uden meddelelse derom.
Ga til www.philips.com/support for at hente den seneste version af brochuren.
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4.1 Oplesning og forvalgte indstillinger

E Maksimal oplasning

Til 226C2/226CL2

1920x1080 ved 60 Hz (analogt input)
1920x1080 ved 60 Hz (digital indgang)

Bl Anbefalet oplasning

Til 226C2/226CL2

1920x1080 ved 60 Hz (digital indgang)

4.2 Automatisk energispare

Hvis der er installeret et VESA DPM overholdende
skaeermkort eller software pa pc'en, kan skeermen
automatisk nedsatte stremforbruget, nar den
ikke bruges. Nar input fra tastatur, mus eller
anden input-enhed registreres, "vagner" skermen
automatisk igen. Nedenstdende tabel viser denne
automatiske energisparefunktions stremforbrug og

signalering:

VESA tilstand | Video V synk Lsynk | Forbrugt | Diodefarve
strom

31,47 640x480 5994 ngz(éng[rzn)
37,88 800x600 60,32 23W
48,36 1024x768 60,00 - __| (norm)

Sovetilstand FRA Nej Nej <05W Hvid
54,00 1152x864 60,00 (norm.) (blinker)
44,77 1280x720 59,86 MemEE R || AR . . ?ngfm\ﬂ)/ IARA
4778 1280x768 59,87 Denne skeerm opfyder ENERGY STAR® kravene. Som ENERGY STAR®
4970 1280x800 59,81 g::};v%rl:;rs\zlr;izt{l;i}ztg‘dette produkt opfylder retningslinjerne ENERGY
60,00 1280x960 60,00
63,89 1280x1024 60,02
47,71 1360x768 6002 Den fglgende opsatning bruges til at male
5547 1440x900 59,90 skaermens stremforbrug.
55,94 1440x900 59,89
75,00 1600x1200 60,00 Indbyggede oplasning: 1920x1080.
64,67 1680x1050 59,88 Kontrast: 50%
65,29 1680x1050 59,95 Lysstyrke: 250 nits
66,59 1920x1080 59,93 Farvetemperatur: 6500k med fuldt, hvidt manster
74,04 1920x1200 59,95 Lyd (fra)
67,50 1920x1080 60,00
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5 Lovmassige oplysninger

Lead-free Product

Lead free display promotes
environmentally sound recovery and
disposal of waste from electrical and
electronic equipment. Toxic substances
like Lead has been eliminated and compliance with
European community’s stringent RoHs directive
mandating restrictions on hazardous substances

in electrical and electronic equipment have been
adhered to in order to make Philips monitors safe

to use throughout its life cycle.

EPEAT

(Wwww.epeat.net)

“The EPEAT (Electronic Product
@ Environmental Assessment Tool)
program evaluates computer

desktops, laptops, and monitors based
on 571 environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.
EPEAT system helps purchasers in the public
and private sectors evaluate, compare and select
desktop computers, notebooks and monitors
based on their environmental attributes. EPEAT
also provides a clear and consistent set of
performance criteria for the design of products,
and provides an opportunity for manufacturers to
secure market recognition for efforts to reduce
the environmental impact of its products.”
Benefits of EPEAT
Reduce use of primary materials
Reduce use of toxic materials
Avoid the disposal of hazardous waste EPEAT’S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following
standards

EN60950-1:2006 (Safety requirement of
Information Technology Equipment)
EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment)
EN55024:1998+A1:2001+A2:2003 (Immunity
requirement of Information Technology
Equipment)

EN61000-3-2:2006 (Limits for Harmonic
Current Emission)
EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and Flicker)
following provisions of directives applicable
2006/95/EC (Low Voltage Directive)
2004/108/EC (EMC Directive)

2005/32/EC (EuP Directive, EC No. 1275/2008
mplementing Directive for Standby and Off
mode power consumption) and is produced
by a manufacturing organization on I1SO9000
level.

The product also comply with the following
standards

1SO9241-307:2008 (Ergonomic requirement,
Analysis and compliance test methods for
electronic visual displays)

GS EK1-2000:2009 (GS mark requirement)
prEN50279:1998 (Low Frequency Electric and
Magnetic fields forVisual Display)

MPR-II (MPR:1990:8/1990:10 Low Frequency
Electric and Magnetic fields)
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This monitor is equipped with a function for saving

energy which supports the VESA Display Power
Management (DPM) standard. This means that the
monitor must be connected to a computer which
supports VESA DPM.Time settings are adjusted
from the system unit by software.

Normal

ON (Active)

White

226C2<25W

One step

operation (typ.)
226CL2< 23W
(typ)
Power Saving Sleep Switch Off | White(blink) <05W (typ)
Alternative 2 Off <05W (typ.)

3)

ENERGY STAR

& Note

As an ENERGY STAR® Partner,

we have determined that this
product meets the ENERGY STAR®
guidelines for energy efficiency.

We recommend you switch off the monitor when
it is not in use for a long time.
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Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation. This
equipment generates, uses and can radiate
radio frequency energy and, if not installed
and used in accordance with the instructions,
may cause harmful interference to radio
communications. However, there is no
guarantee that interference will not occur
in a particular installation. If this equipment
does cause harmful interference to radio or
television reception, which can be determined
by turning the equipment off and on, the
user is encouraged to try to correct the
interference by one or more of the following
measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

* Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced radio/
TV technician for help.

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority to
operate the equipment.

Use only RF shielded cable that was supplied with
the monitor when connecting this monitor to a
computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to rain
or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.
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Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré

conforme auxlimites des appareils numériques
de class B,aux termes de l'article 15 Des
regles de la FCC. Ces limites sont concues

de fagon a fourir une protection raisonnable
contre les interférences nuisibles dans le cadre
d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est pas
installé et utilisé selon les consignes données,
peuvent causer des interférences nuisibles aux
communications radio.

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une installation
particuliere. Si cet appareil est la cause
d'interférences nuisibles pour la réception des
sighaux de radio ou de télévision, ce qui peut

étre décelé en fermant I'équipement, puis en
le remettant en fonction, |'utilisateur pourrait

essayer de corriger la situation en prenant les

mesures suivantes:

* Réorienter ou déplacer I'antenne de réception.

* Augmenter la distance entre |'équipement et
le récepteur.

* Brancher I'équipement sur un autre circuit que

celui utilisé par le récepteur.
* Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour

les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTETOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

This devica belongs to catagory B devices as described in EN 55022, unless it is spacifi-
cally stated that it is a Class A device on the specification labal. The following appliss to
davicas in Class A of EN 55022 (radius of profection up o 30 metars). The user of the
davics is obliged to take all stape necessary to remove sources of infarfersnce 1o tela-
communication or other devicss.

Pulmdnan[nutrpmémmw poditade uvadeno, Ze spadé do do ffidy A podie EN 55022,

spada automaticky do tfidy B podie EN 55022, Pro zafizeni zafazend do tidy A (chranné
pésmo 30m) podie EN 55022 platl nésledujicl. Dojde-li k rudanl telekomunikatnich nebo
Pnych zafizeni je ufvatel povinnen provést takowd opatfgnl, aby neSeni odstranil.




Polish Center for Testing and Certification
Notice

The equipment should draw power from a socket
with an attached protection circuit (a three-
prong socket). All equipment that works together
(computer, monitor, printer; and so on) should
have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1T-42107
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacyi
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easilajgeego 2 griaedka, kidre powinno enajdowad ssg w pobli m'adJ einia | byd 2atwo desigpne.

#nak bezpivesetstwa " potwiendea zpodnosé uresdeenia 2 wynaganiami beepieczeisiva
whytkowarsia zawartyini w PNAIT-A2107 § PN-ROEA6251.

Pozostale instrukcje bezpieczenisiwa
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10 spowodowat pedar lub poraenie pr.(r)cm Paprzez swarcie clementin wewngsranych.
* System Lomwlcrow; pnmmumajdowaf sl 2 dala od wcjmlw @ ridel cn:pla Posadio.
: ralei lncyjreych. Nabeiy un ilzenia luinych papierin pod
knmpmk'nr.n(uml eszirana kompulerd w ciasnym mumu ru i cyrkulacyi poi-
etrza wokil nicgo.
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR DU
STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

S@ORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT ER
NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA,

BSMI Notice (Taiwan Only)

HelaEiERCEE |




Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht den
in der "Verordnung Uber den Schutz vor Schaden
durch Rontgenstrahlen" festgelegten Vorschriften.

Auf der Rickwand des Gerdtes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften tber
die Bauart von Stérstrahlern nach Anlage lll & 5
Abs. 4 der Rontgenverordnung erfillt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.

2. nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildrohre nur eine bauartgleiche
eingebaut wird.

Aus ergonomischen Grinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf dunklem
Untergrund zu verwenden (schlechte Lesbarkeit
und erhdhte Augenbelastung bei zu geringem
Zeichenkontrast wéren die Folge).

Der arbeitsplatzbezogene Schalldruckpegel nach
DIN 45 635 betrdgt 70dB (A) oder weniger.

[A]

ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.
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China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and LCD
monitor which are produced and sold for China
market have to meet China RoHS request.
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6 Kundeservice og garanti

Kundeservice og garanti

V/ELG DIT LAND/OMRADE FOR AT SE
OPLYSNINGER OM DIN GARANTIDAKNING

VESTEUROPA

Ostrig / Belgien / Danmark / Frankrig / Tyskland
/ Greekenland / Finland / Irland / Italien /
Luxembourg / Holland / Norge / Portugal /
Sverige / Schweiz / Spanien / Storbritannien /
Polen

GSTEUROPA
Tjekkiet / Ungarn / Rusland / Slovakiet / Slovenien
/ Tyrkiet

LATINAMERIKA
Argentina / Brasilien

NORDAMERIKA
Canada / USA

STILLEHAVSLANDENE
Australien / New Zealand

ASIEN

Kina / Hong Kong / Indien / Indonesien / Korea
/ Malaysia / Pakistan / Filippinerne / Singapore /
Taiwan / Thailand /Vietnam

AFRIKA
Sydafrika

MELLEMO@STEN
Forenede Arabiske Emirater

Din Philips F1rst Choice garanti
Tak fordi du valgte at kebe denne Philips-skaerm.

Alle Philips-skaerme er konstrueret
og fremstillet efter hgje standarder
og giver funktion i hgj kvalitet,
brugervenlighed og nem installation.
Hvis du steder pa vanskeligheder
under installation eller anvendelse af dette produkt,
bedes du kontakte Philips hjeelpecenter direkte for
at fa gleede af din Philips F1rst Choice garanti. Med
denne todrige garanti er byttemodel du berettiget
til byttemodel leveret pa adressen, hvis skeermen
viser sig at veere behaeftet med mangler eller fejl.
Philips tilstreeber en udskiftning inden for 48 timer
efter dit opkald..

Hvad er daekket?

Philips F1rst Choice Warranty gelder i Andorra,
Dstrig, Belgien, Cypern, Danmark, Frankrig, Tyskland,
Grakenland, Finland, Irland, Italien, Liechtenstein,
Luxemburg, Monaco, Nederlandende, Norge,
Polen, Portugal, Sverige, Schweiz, Spanien og
Storbritannien og kun for skeerme, der er
oprindeligt konstrueret, fremstillet, godkendt og/
eller autoriseret til brug i disse lande.

Garantidaekningen begynder fra den dag hvor
kgbte din monitor. | to ar derefter, byttes skaermen
til en skaerm i mindst tilsvarende model i tilfelde af
defekter, der er omfattet af garantien.

Ombytningsskaermen vil veere din ejendom, og
Philips beholder den defekte/oprindelige skaerm.
For ombytningsskeermen geelder den samme
garantiperiode som for den oprindelige skeerm,
nemlig 24 méaneder fra kebsdatoen for den
oprindelige skarm.
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Hvad er undtaget?

Philips F1rst Choice garanti deekker under
forudseetning af, at produktet behandles

korrekt og anvendes til det tilsigtede formal i
overensstemmelse med dens betjeningsvejledning,
og ved forevisning af den originale faktura

eller kvittering med angivelse af kgbsdatoen,
forhandlerens navn samt model og
produktionsnummer for produktet.

Philips F1rst Choice garanti geelder eventuelt ikke,
hvis:
*  Dokumenterne er endret eller pad nogen
made er gjort uleselige.

Modellen eller produktionsnummeret pa
produktet er &ndret, slettet, fiernet eller gjort
uleseligt.

Reparationer eller produktendringer er udfert
af vautoriserede serviceorganisationer eller
personer.

Skade er opstaet som fglge af uheld, herunder
men ikke begranset til lynnedslag, vand eller
ild, misbrug eller forsemmelighed.
Modtageproblemer fordrsaget af signalforhold,
kabel eller antennesystemer udenfor
produktet;

Defekter, der er fordrsaget af misbrug af
monitoren:

Produkter der kreever modifikation eller
tilpasning for, at de kan opfylde de lokale eller
nationale tekniske standarder, som geelder i
lande, for hvilket produktet ikke oprindeligt
var designet, fremstillet, godkendt og/eller
autoriseret. Derfor skal du altid kontrollere om
et produkt kan bruges i et specifikt land.
Bemaerk, at Philips F1rst Choice garantien

ikke deekker produkter, der ikke oprindeligt

er konstrueret, fremstillet godkendt og/eller
autoriseret til brug i Philips F1rst Choice-
lande. | sddanne tilfeelde geelder Philips
verdensomspzaendende garanti.

Kun et klik vaek

| tilfelde af problemer; anbefaler vi at du leeser
instruktionsvejledningen grundigt, eller gar ind pa
www.philips.com/support website for yderligere
support.

Kun en telefonopringning borte

For at undgd unedig ulejlighed, tilrdder vi at
lese betjeningsvejledningen omhyggeligt eller fa
yderligere hjaelp ved at ga til Web-stedet www.
philips.com/support, fer du kontakter Philips
hjeelpecenter.

For at fa problemet last hurtigst og nemt, bedes
du have falgende oplysninger klar, for du kontakter
Philips hjeelpecenteret:
*  Philips typenummer
Philips serienummer
Kebsdato (kopi af kebsbevis kan veere
pakrevet)
PC processor:
o CUP og grafikkortsnavn og driverversion
o Operativsystem
o Program bruges
Andre installerede kort

Huvis falgende oplysninger er til radighed, vil det
ogsa befordre sagen:

*  Kgbsbevis med angivelse af:

Kebsdato, forhandlernavn, model og
produktserienummer.

Den fuldsteendige adresse, hvor den
fejlbehaftede skaerm skal afhentes, og
ombytningsmodellen skal leveres.

Philips-kundeservice findes over hele verden. Klik
her for at fa adgang til Lite kontaktoplysninger.

Eller du kan nd os via:Web-sted:
Websted: http://www.philips.com/support
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F1rst Choice kontaktoplysningerne

Land Kode |Telefonnummer Takst
Dstrig +43 0810 000206 €0,07
Belgien +32 078 250851 €0,06
Danmark +45 3525 8761 Lokal opkaldstakst
Finland +358  [840 320 041 €0,08
Luxembourg +352 |26 84 30 00 Lokal opkaldstakst
Holland +31 0900 0400 063 €0,10
Norge +47 2270 8250 Lokal opkaldstakst
Polen +48 0223491505 Lokal opkaldstakst
Portugal +351 2 1359 1440 Lokal opkaldstakst
Spanien +34 902 888 785 €0,10
Sverige +46 08 632 0016 Lokal opkaldstakst
Schweiz +41 02 2310 2116 Lokal opkaldstakst
Storbritannien +44 0207 949 0069 Lokal opkaldstakst
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International garanti

Keere kunde

Tak, fordi du kebte dette Philips produkt, der
er konstrueret og fremstillet efter hgjeste
kvalitetsstandarder. Hvis noget alligevel skulle
gd galt, med dette produkt, garanterer Philips
gratis arbejdslen og reservedele, reparationen
er foretaget, i en periode pa 24 maneder fra
kgbsdatoen.

Hvad er dakket?

Denne garanti fra Philips i Central- og @steuropa,
geelder i Tjekkiet, Ungarn, Slovakiet, Slovenien,
Rusland og Tyrkiet og kun for monitorer der
oprindelig er designet, fremstillet, godkendt og/
eller autoriseret til brug i disse lande..

Garantidakningen begynder fra den dag hvor du
kegbte din monitor. | 2 ar derefter; vil din monitor
blive repareret i tilfelde af defekter, der er deekket
af garantien.

Hvad er undtaget?

Philips garanti deekker under forudsatning af, at
produktet behandles korrekt og anvendes til det
tilsigtede formal i overensstemmelse med dens
betjeningsvejledning, og ved forevisning af den
originale faktura eller kvittering med angivelse af
kegbsdatoen, forhandlerens navn samt model og
produktionsnummer for produktet.

Philips garanti gaelder eventuelt ikke, hvis:

*  Dokumenterne er @ndret eller pa nogen
made er gjort uleselige.

Modellen eller produktionsnummeret pa
produktet er &ndret, slettet, fiernet eller gjort
uleeseligt.

Reparationer eller produkteendringer er udfert
af vautoriserede serviceorganisationer eller
personer.

Skade er opstaet som fglge af uheld, herunder
men ikke begreenset til lyn, vand eller ild,
misbrug eller forssmmelighed.

Modtageproblemer fordrsaget af signalforhold,
kabel eller antennesystemer udenfor
produktet;

Defekter, der er fordrsaget af misbrug af
monitoren:;

Produkter der kraever modifikation eller
tilpasning for, at de kan opfylde de lokale eller
nationale tekniske standarder, som gaelder i
lande, for hvilket produktet ikke oprindeligt
var designet, fremstillet, godkendt og/eller
autoriseret. Derfor skal du altid kontrollere om
et produkt kan bruges i et specifikt land.

Bemaerk, at produktet ikke er defekt under denne
garanti i tilfelde, hvor aendringer er pakreevet, for
at produktet kan overholde lokale eller nationale
tekniske standarder, der geelder i lande, hvortil
produktet ikke oprindeligt er konstrueret og/eller
fremstillet. Derfor skal du altid kontrollere om et
produkt kan bruges i et specifikt land.

Kun et klik vek

| tilfeelde af problemer; anbefaler vi at du leser
instruktionsvejledningen grundigt, eller gar ind pa
www.philips.com/support website for yderligere
support.

Kun en telefonopringning borte

For at undga unedig ulejlighed, tilrader vi, at
du leeser betjeningsvejledningen omhyggeligt,
for du kontakter vore forhandlere eller
informationscenter.

| tilfeelde af at dit Philips produkt ikke virker
korrekt, eller er defekt, kontakt venligst din
Philips forhandler eller kontakt Philips Service og

Consumer Center direkte.

Websted: http://www.philips.com/support
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Forbruger Informationscentre

Argentina / Australien / Brasilien / Canada / New
Zealand / Hviderusland / Bulgarien / Kroatien /
Tjekkiet / Estland / Forenede Arabiske Emirater /
Hong Kong / Ungarn / Indien / Indonesien / Israel
/ Letland / Litauen / Malaysia / Mellemgsten +
Nordafrika / New Zealand / Pakistan / Rumaenien
/ Rusland / Serbien & Montenegro / Singapore

/ Slovakiet / Slovenien / Sydafrika / Sydkorea /
Taiwan / Filippinerne / Thailand / Tyrkiet / Ukraine /
Vietnam

OSTEUROPA

BELARUS Technic al Center of |V IBA
M. Bogdanovich str. 155

BY - 220040 Minsk

Tel: +37517 217 33 86

HVIDERUSLAND
Service. BY

Petrus Brovky st. 19 —101-B
220072, Minsk

Hviderusland

BULGARIEN

LAN Service

140, Mimi Balkanska Str.
Office center Translog
1540 Sofia, Bulgarien
Tel: +359 2 960 2360
www.lan-service.bg

TJEKKIET
General Consumer Information Center
800 142100

Xpectrum

Lu.nd 591/4

CZ - 160 00 Praha 6 TIf: 800 100 697 or 220 121
435

E-mailiinfo@xpectrum.cz

www.xpectrum.cz

KROATIEN
Renoprom d.o.o.
Ljubljanska 4,

Sv. Nedjelja, 10431
Kroatien

Tel: +385 1 333 0974

ESTLAND

FUJITSU SERVICES OU
Akadeemia tee 21G
EE-12618 Tallinn

Tel: +372 6519900
www.ee.invia.fujitsu.com

UNGARN

Serware Szerviz
Vizimolnar u. 2-4

HU - 1031 Budapest

Tel: +36 1 2426331
E-mail: inbox@serware.hu
www.serware.hu

UNGARN

Profi Service Center Ltd.

123 Kulso-Vaci Street,

H-1044 Budapest (Europeaisk center)
UNGARN

Tel: +36 1 814 8080

E-mail: m.andras@psc.hu

LETLAND

ServiceNet LV

Jelgavas iela 36

LV - 1055 Riga,

Tel: +371 7460399

E-mail: serviss@servicenet.lv

LITAUEN

ServiceNet LT

Gaiziunu G. 3

LT - 3009 KAUNAS

Tel: +370 7400088

E-mail: servisas@servicenet.lt
www.servicenet.Ilt
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RUMANIEN

Blue Ridge Int'l Computers SRL
115, Mihai Eminescu St., Sector 2
RO - 020074 Bucharest

Tel: +40 21 2101969

SERBIEN & MONTENEGRO
Kim Tec d.o.o.

Viline vode bb, Slobodna zona
Beograd L12/3

11000 Belgrade

Serbien

Tel: +381 11 20 70 684

SLOVAKIET
General Consumer Information Center
0800004551

Datalan Servisne Stredisko
Puchovska 8

SK - 831 06 Bratislava

Tel: +421 2 49207155
E-mail: servis@datalan.sk

SLOVENIEN

PC HAND

Brezovce 10

Sl - 1236 Trzin

Tel: +386 1 530 08 24
E-mail: servis@pchand.si

RUSLAND

CPS

18, Shelepihinskaya nab.
123290 Moscow
Rusland

Tel: +7(495)797 3434

Profservice:

14A -3, 2Karacharovskaya str;
109202, Moscow ,

Rusland

Tel: +7(095)170-5401

TYRKIET

Turk Philips Ticaret AS.

Yukari Dudullu Org.San.Bolgesi
2.Cadde No:22
34776-Umraniye/Istanbul

Tel: (0800)-261 33 02

UKRAINE

Comel

Shevchenko street 32

UA - 49030 Dnepropetrovsk
Tel: +380 562320045
www.csp-comel.com LLC Topaz Company
Topaz-Service Company,
Mishina str; 3,

Kiev

Ukraine-03151

Tel: +38 044 245 73 31

LATINAMERIKA

ARGENTINA

Azopardo 1480.

(C1107ADZ) Cdad. de Buenos Aires
Tel: 0800 3330 856

E-mail: CIC.monitores@Philips.com

BRASILIEN

Alameda Raja Gabaglia, 188 - 10°Andar - V.
Olimpia - S. Paulo/SP - CEP 04551-090 -
Brasilien

Tel: 0800-7254101

E-mail: CIC.monitores@Philips.com

Stillehavsomradet

AUSTRALIEN

Firma: AGOS NETWORK PTY LTD

Adresse: 4/5 Dursley Road,Yenorra, NSW 2161,
Australien

Tel: 1300 360 386

Fax : +61-2-80808147

E-mail: philips@agos.com.au

Abningstider: Man. til fred. 8:00 -19:30pm



NEW ZEALAND

Firma: Visual Group Ltd.

Adresse: 28 Walls Rd Penrose Auckland
Tel: 0800 657447

Fax: 09 5809607

E-mail: vai.ravindran@visualgroup.co.nz
Abningstider: Man. til fred. 8:30 til 17:30pm

Asien

HONG KONG/Macau

Firmanavn: PHK Service Limited

Adresse: Flat A, 10/F,, Pak Sun Building, 103 - 107
Wo Yi Hop Road, Kwai Chung, New Territories,
Hong Kong

Tel: (852) 2610-6908 / (852) 2610-6929 for Hong
Kong og (853) 2856-2277 for Macau

Fax : (852) 2485 3574 for Hong Kong og (853)
2856 1498 for Macau

E-mail: enquiry@phkservice.com.hk
Abningstider: Man. til lar. 9:00 til 18:00pm

Indien

Firma: REDINGTON INDIA LTD

Adresse: SPL Guindy House, 95 Mount Road,
Chennai 600032, Indien

Tel: +9144-42243352/353

E-mail: aftersales@in.aocmonitor.com
Abningstider: Man. til fred. 9:00 til 17:30PM; Ler.
9:00 til 13:00pm

Indonesien

Firmanavn: PT. Gadingsari elektronika Prima
Adresse: Komplek Pinang 8, JI. Ciputat raya No. 8F,
Pondok Pinang. Jakarta

Tel:021-750909053, 021-750909056

Fax :021-7510982

E-mail: gepta@cbn.net.id

Abningstider: Man. til fred. 8:30 til 16:30pm;

Lor: 8:30 til 14:00pm
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Yderligere servicesteder:

1. Philips Building JI. Buncit Raya Kav 99. Jakarta
Selatan.

Tel: 021-7940040, lokal 1722/1724, 98249295,
70980942

Jl. Tanah Abang 1 no 12S. Jakarta Pusat.
Tel: 021-3455150, 34835453

Rukan City Home no H31, Gading Square. JI.
Bulevar Barat. Kelapa Gading. Jakarta Utara. Tel:
021-45870601, 98131424

Sydkorea

Firma: PCS One Korea Ltd.

Adresse: 112-2, Banpo-dong, Seocho-ku, Seoul,
137-040, Korea

Call CenterTel: 080-600-6600

Tel: 82 2 591 1528

Fax :82 2 595 9688

E-mail: cic_korea@philips.com

Abningstider: Man. til fred. 9:00 til 18:00pm; Lar:
9:00 til 13:00pm

Malaysia

Firma: After Market Solutions (CE) Sdn Bhd
Adresse: Lot 6. Jalan 225/51A, 46100 Petaling Jaya,
Selangor DE, Malaysia.

Tel: 603 7953 3370

Philips Info Line: 1-800-880-180

Fax :603 7953 3338

E-mail: pceinfo.my@philips.com

Abningstider: Man. til fred. 8:15 til 17:15pm; Ler.
9:00 til 13:00pm

Pakistan

Philips Consumer Service

Adresse: Mubarak manzil, 39, Garden Road, Saddar;
Karachi-74400

Tel: (9221) 2737411-16

Fax :(9221) 2721167

E-mail: care@philips.com

Websted: www.philips.com.p



Singapore

Firma: Philips Electronics Singapore Pte Ltd (Philips

Consumer Care Center)

Adresse: 620A Lorong 1 Toa Payoh, TP4 Building
Level 1, Singapore 319762

Tel: (65) 6882 3999

Fax : (65) 62508037

E-mail: consumer.care.sg@philips.com
Abningstider: Man. til fred. 9:00 til 18:00pm; L.
9:00 til 13:00pm

Taiwan

Firma: FETEC.CO

Adresse: 3F, No.6, Lane 205, Sec. 1, Chang Hsing
Rd, Lu Chu Hs, Taoyuan, Taiwan RO.C 33800
Kundepleje: 0800-231-099

Tel: (03)2120336

Fax:(03)3129184

E-mail: knlinO8@xuite.net

Abningstider: Man. til fred. 8:30 til 21:00pm

Thailand

Firma: Axis Computer System Co.,, Ltd.

Adresse: 1421 Soi Lardprao 94, Srivara Town In
Town Soi 3 Road, Wangthonglang, Bangkok 10310
Thailand

Tel: (662) 934-5498

Fax : (662) 934-5499

E-mail: axisS@axiscomputer.co:th

Abningstider: Man. til fred. 8:30 til 17:30pm

Glee Electronics Inc
Kontakt tlf. (632) 636-3636 / 7064028 til 29
Fax nr. (632) 7064026

Modtagende centre

NEO CARE - Megamall

4th Level Cyberzone, Building B,
SM Megamall, Mandaluyong City

NEO CARE - SM North EDSA
4th Level Cyberzone, Annex Bldg.
SM City North EDSA, Quezon City
4411610

MDR Microware Sales Inc.

Cebu Branch

N. Escario corner Clavano St., Cebu City Phils.
Tel: 255-4415/ 255-3242/253-9361/4124864 il
67

Sen. tif. 0922-8210045 til 46

Davao Office:

C. Arellano St, Davao City 8000
082- 225-3021/225-3022

Sen. tif. 0922-8210015

CDO Office:

1445 Corrales Ext,CDO City
088-856-8540/856-8541

Sen. tIf. 0922-8210080

lloilo Office:

C. Lim Comp., Gomez St., lloilo City
# 033 338-4159/ 033 508-3741
Sen. tIf. 0922-8808850

Afrika

SYDAFRIKA

Firmanavn: Sylvara Technologies Pty Ltd
Adresse: Ho Address Palm Springs Centre
Christoffel Road Van Riebeeck Park Kempton Park,
Sydafrika

Tel: +27878084456

Fax : +2711 391 1060

E-mail: customercare@philipssupport.co.za
Abningstider: Man. til fre. 8:00 til 17:00pm

Mellemgsten

Mellemasten + Nordafrika

Firma: AL SHAHD COMPUTER L.L.C

Adresse: P O. BOX: 29024, DUBAI, UNITED
ARAB EMIRATES

Tel: 00971 4 2276525

Fax: 00971 4 2276242

E-mail: shahd52@eim.ae

Abningstider: Lar. til Tor: 9:00 til 13:00pm & 16:00
til 20:00pm
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Israel

Firma: Eastronics LTD

Adresse: 13 Rozanis St. PO.B. 39300, Tel Aviv
61392 lsrael

Tel: 1-800-567000 gratisnummer i Israel; (972-50-
8353722 efter dbningstid indtil 20:00)

Fax :972-3-6458759

E-mail: eastronics@eastronics.co.il

Abningstider: Sgn. til Tor. 08:00 - 18:00

Din Philips F1rst Choice garanti(USA)
Tak fordi du valgte at kebe denne Philips-skaerm.

Alle Philips-skaerme er konstrueret

og fremstillet efter hgje standarder

og giver funktion i hgj kvalitet,
" brugervenlighed og nem installation.

Hvis du steder pa vanskeligheder
under installation eller anvendelse af dette
produkt, bedes du kontakte Philips direkte for at
fa gleede af din Philips F1rst Choice garanti. Denne
tredrige garanti berettiger dig til at fa byttet model
pa stedet inden 48 timer efter modtagelsen af
dit opkald inden for det farste ar efter kab. Hvis
du har problemer med skaermen inden for det
andet eller tredje ar efter kab, reparerer vi den,
efter at den er fremsendt for kundens regning til
servicestedet og returnerer den gratis til kunden
inden fem arbejdsdage.

=
Z)

[
it

BEGRANSET GARANTI (Computerskarm)

Klik her for at komme til Warranty Registration
Card.

Tre ar pa gratis arbejdslen / tre ars gratis service
pa dele / et ar pa udskiftning *

*Produktet udskiftes til et nyt eller renoveres til de
oprindelige specifikationer inden for to arbejdsdage
i det forste ar. Dette produkt skal indsendes pa
kundens regning til service i garantiens 2. og 3.ar.
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HVEM ER DAKKET?

Du skal have et kgbsbevis for at kunne modtage
service under garantien. En kvittering eller et andet
dokument, der viser, at du har kebt produktet,
betragtes som et kebsbevis. Heeft det pa denne
vejledning og hav begge dele i neerheden.

HVAD DAKKES?

Garantien daekker fra den dag, du keber dit
produkt. | de efterfglgende tre dr repareres

eller udskiftes alle dele, og arbejdslgnnen er

gratis. Efter tre ar fra kebsdatoen betaler du for
udskiftning eller reparation af alle dele samt for alle
arbejdsomkostninger.

Alle dele, herunder reparerede og udskiftede
dele, daekkes kun i den oprindelige garantiperiode.
Nar garantien udlgber pa det originale produkt,
udlgber ogsa garantien pa alle udskiftede og
reparerede produkter og dele.

HVAD ER UDELUKKET?

Garantien deekker ikke:

Arbejdslgn for installation eller opseetning

af produktet, justering af brugerdefinerede
kontrolelementer pa produktet, og installation eller
reparation af antennesystemer uden for produktet.

Produktreparation og/eller udskiftning af dele som
folge af misbrug, uheld, uautoriseret reparation
eller af anden grund, der er uden for Philips
Consumer Electronics indflydelse.

Modtageproblemer forarsaget af signalforhold,
kabel eller antennesystemer udenfor produktet;

Et produkt, der kreever aendringer eller tilpasninger
for at ggre det i stand til at fungere i et andet land
end det, til hvilket det er konstrueret, fremstillet,
godkendt og/eller autoriseret, eller reparation af
produkter, der er skadet af disse modifikationer.

Opstaede skader eller folgeskader fordrsaget af
produktet. (Visse stater tillader ikke udelukkelse

af opstaede skader eller fglgeskader, hvorfor
ovenstaende udelukkelse eventuelt ikke gaelder for
dig. Dette omfatter, men begreenses ikke til optaget
materiale, uanset, om det er med copyright eller

ej)

Modellen eller produktionsnummeret pa
produktet er endret, slettet, fiernet eller gjort
uleeseligt.

Hvor ER DER SERVICE TIL RADIGHED?
Service under garantien er til radighed i alle
lande, hvor produktet officielt distribueres af
Philips Consumer Electronics. | lande, hvor Philips
Consumer Electronics ikke distribuerer produktet,
vil den lokale Philips serviceorganisation tilstreebe
at give service (skent der kan opsta forsinkelse,
hvis de korrekte reservedele og tekniske
handbgger ikke er umiddelbart til radighed).

Hvor FAR JEG FLERE OPLYSNINGER?

Du kan fa flere oplysninger ved at kontakte Philips
Customer Care Center ved at ringe pa (877) 835-
1838 (Kun for kunder i USA) eller (919) 573-
7855.

Inden du anmoder om service...

Se i vejledningen, fer du rekvirerer service.
Justering af de kontrolelementer; der omtales her,
kan spare dig for en opringning efter service.
YDELSE AF GARANTISERVICE | USA,, PUERTO
RICO ELLER DE AMERIKANSKE JOMFRUQER...
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Kontakt Philips kundeoplysningscenter pa
nedenstaende telefonnummer for at fa
produktassistance og fremgangsmader ved ydelse
af service:

Philips kundeservicecenter
(877) 835-1838 eller (919) 573-7855

(I USA,, Puerto Rico og de amerikanske jomfruger
er varigheden af alle antydede garantier; herunder
garantier om salgbarhed og egnethed til et
bestemt formal begraenset til varigheden af denne
udtrykkelige garanti. Da visse stater dog ikke
tillader begransninger , for; hvor leenge en antydet
garanti md vare, gelder denne begransning
eventuelt ikke i det aktuelle tilfeelde.)

YDELSE AF GARANTISERVICE | KANADA...

Kontakt Philips pa:
(800) 479-6696

Der yders tre ar pa gratis dele og tre ars gratis
arbejdslen pa Philips Canada depot eller et af de
autoriserede servicecentre.

(I Kanada gives denne garanti i stedet for alle
andre garantier. Der udtrykkes eller antydes

ikke andre garantier; herunder garantier om
salgbarhed eller egnethed til et bestemt formal.
Philips heefter under ingen omsteendigheder for
nogen direkte, indirekte, specielle, opstdede skade
eller folgeskader, uanset hvordan den er padraget,
heller ikke hvis der er underrettet om risikoen for
sadanne skader)

HUSK...Noter model- og serienumre pa produktet
nedenfor.

Model- #

Serienumre #

Denne garanti giver dig visse juridiske rettigheder.
Du kan have andre rettigheder; athangigt af den
pageeldende stat/provins.

For du kontakter Philips, skal du have fglgende
oplysninger parat, sa vi hurtigt kan lgse dit
problem.
*  Philips typenummer
Philips serienummer
Kebsdato (kopi af kebsbevis kan vaere
pakreevet)
PC processor:
o CUP og grafikkortsnavn og driverversion
o Operativsystem
o Program bruges
Andre installerede kort
Hvis falgende oplysninger er til radighed, vil
det ogsa befordre sagen:
Kebsbevis med angivelse af:
Kabsdato, forhandlernavn, model og
produktserienummer:
Den fulde adresse, hvortil ombytningsmodellen
skal leveres.

Kun en telefonopringning borte
Philips-kundeservice findes over hele verden. |
Amerika kan du kontakte Philips-kundeservice
mandag-fredag fra 8:00 AM-9:00 PM Eastern Time
(ET) og lezrdage fra 10:.00 AM-5:00 PM (ET) ved
hjeelp af et af kontakt-telefonnumrene.

For flere oplysninger om dette og om flere
fremragende Philips-produkter; sd besgg vores

hjemmeside pa:

Websted: http://www.philips.com
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Din internationale garanti
Kaere kunde

Tak, fordi du kebte dette Philips produkt, der
er konstrueret og fremstillet efter hgjeste
kvalitetsstandarder.

Huvis noget alligevel skulle ga galt, med dette
produkt, garanterer Philips gratis arbejdslen og
reservedele, uanset i hvilket land, reparationen
er foretaget, i en periode pa 12 maneder

fra kebsdatoen. Denne internationale

Philips garanti supplerer den eksisterende
nationale garantiforpligtelse fra forhandlere

og Philips i kebslandet og pavirker ikke dine
forfatningsmaessige rettigheder som kunde og
forbruger.

Philips garanti deekker under forudsatning af, at
produktet behandles korrekt og anvendes til det
tilsigtede formal i overensstemmelse med dens
betjeningsvejledning, og ved forevisning af den
originale faktura eller kvittering med angivelse af
kegbsdatoen, forhandlerens navn samt model og
produktionsnummer for produktet.

Philips garanti gaelder eventuelt ikke, hvis:

*  Dokumenterne er ndret eller pa nogen
made er gjort uleselige.

Modellen eller produktionsnummeret pa
produktet er &ndret, slettet, fiernet eller gjort
uleeseligt.

Reparationer eller produkteendringer er udfert
af uautoriserede serviceorganisationer eller
personer.

Skade er opstaet som fglge af uheld, herunder
men ikke begreenset til lyn, vand eller ild,
misbrug eller forssmmelighed.
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Bemaerk, at produktet ikke er defekt under denne
garanti i tilfelde, hvor aendringer er pakravet, for
at produktet kan overholde lokale eller nationale
tekniske standarder, der geelder i lande, hvortil
produktet ikke oprindeligt er konstrueret og/eller
fremstillet. Derfor skal du altid kontrollere om et
produkt kan bruges i et specifikt land.

Huvis dit Philips produkt ikke fungerer korrekt eller
er defekt, bedes du kontakte din Philips forhandler
Hvis du har behov for service under et ophold i et
andet land, kan der opgives en forhandleradresse
til dig af Philips kundeservice i det pageldende
land, hvis telefon- og faxnummer kan findes i den
relevant del af dette hafte.

For at undgd unedig ulejlighed tilrdder vi at
lzese betjeningsvejledningen omhyggeligt, for du
kontakter din forhandler. Hvis du har spergsmal,
din forhandler ikke kan besvare, eller har andre
relevante spegrgsmal, bedes du kontakte Philips
forbrugeroplysningscentre eller ga pa:

Websted: http://www.philips.com



7 Fejlfinding og FAQ

7.1 Fejlfinding

Denne side omhandler problemer, som kan klares
af brugeren selv. Hvis problemet stadig er der; efter
at du har provet disse lasninger, skal du kontakte
Philips's Kundeservice.

El Almindelige problemer

Intet billede (stremdiode lyser ikke)

* Kontroller; at el-ledningen er anbragt i
stikkontakten og bag pa skeermen.

» Kontroller fgrst, at stramkontakten foran pa
skeermen er i OFF (FRA) position og tryk den
derefter i ON (TIL) position.

Intet billede (stremdiode blinker hvidt)

»  Kontroller, at der er teendt for computeren.

*  Kontroller, at signalkablet er korrekt forbundet
til computeren.

» kontroller, at der ikke er nogen bgjede stikben
i signalkablets tilslutningsende. Hvis der er det,
skal du fa kablet repareret eller udskiftet.

* Energisparefunktionen kan veere aktiveret

Skeerm siger

* Kontroller, at signalkablet er korrekt
forbundet til computeren. (Se ogsa quick-
installationsvejledningen).

* Tjek om skaermkablets stikben er bgjede.

»  Kontroller, at der er teendt for computeren.

AUTO (AUTOM.)-knappen virker ikke

*  Den automatiske funktion fungerer kun i
VGA analog-tilstand. Hvis resultatet ikke er
tilfredsstillende, kan der foretages manuelle
justeringer via OSD-menuen.

& Bemarkning
Den automatiske funktion er ikke ngdvendig i
DVI digital-tilstand.

Synlige tegn pa rog eller gnister

*  Forseg ikke at fejlfinde

*  Treek straks skaermens stik ud af stikkontakten

* Kontakt straks en repreesentant fra Philips
kundeafdeling.

Bl Billeddannelses-problemer

Billedet er ikke centreret

* Justér billedets position med funktionen “Auto’
(Automatisk) i OSD-menuerne.

* Juster billedpositionen med Phase/Clock (Fase/
Klokke) i OSD-menuernen. Den kan kun
bruges i VGA-tilstand.

Billede vibrerer pa skarmen
* Tjek, at signalkablet er korrekt forbundet til
grafikkortet eller pc'en.

Lodret flimren

* Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/Clock
(Fase/Klokke) i OSD-menuernen. Den kan kun
bruges i VGA-tilstand.



Vandret flimren

e Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

*  Eliminer de lodrette bjeelker med Phase/Clock
(Fase/Klokke) i USD hovedmenuen. Den kan
kun bruges i VGA-tilstand.

Billedet er slgret, uklart eller for morkt
* Indstil kontrast og lysstyrke i OSD.

Der forbliver et "efterbillede",
"indbrandingsbillede" eller "spogelsesbillede”,
efter at der er slukket for stremmen.

»  Uafbrudt visning af stille eller statiske billeder
over en lengere periode kan fordrsage,
at det ""braendes fast” pa skaermen, dvs. de
sakaldte “spagelsesbilleder” pa din skarm.
"Fastbreending” og "spegelsesbilleder” er
velkendte feenomener inden for LCD-
skeermteknologien. | de fleste tilfeelde
forsvinder "indbreending” eller "efterbillede"
eller "spogelsesbillede" gradvist, efter at
stremmen er slaet fra.

* Serg altid for at aktivere en pauseskaerm, der
bevaeger sig, nar skeermen efterlades uden at
blive anvendt.

*  Sgrg altid for at aktivere et program, der
opdaterer skeermbilledet regelmaessig, hvis
LCD-skarmen viser indhold, der ikke skifter:

* Imidlertid forsvinder alvorligere tilfeelde af
“fastbreending” og “‘spegelsesbilleder’ ikke
og kan ej heller fiernes ved reparation.
Ovennzvnte skader er ikke daekket af
garantien.

Billedet er forvranget. Tekst er utydelig eller

sloret.

* Indstil pc'ens skeermoplasning som skaermens
anbefalede, native oplgsning.

Der ses rgde, bla, mgrke og hvide pletter pa

skaermen

*  De resterende prikker er normale i den
flydende krystal-teknik, der bruges i dag. Se
politikken om pixels for yderligere oplysninger.

"Taendt"-lyset er for kraftigt. Det forstyrrer
* Dukan justere “Taendt"-lyset med Stremdiode
i OSD-menuerne.

H Lydproblem

Ingen lyd

*  Kontrollér, om lydkablet er korrekt sluttet til
pc'en og skarmen.

*  Kontrollér, at lyden ikke er slaet fra. Tryk pa
OSD'ens “Menu”, vaelg “Audio” (Lyd) og
derefter "Mute” (Lyd fra). Marker i position
“Off” (Fra).

*  Tryk pa“Volume” (Lydstyrke) i OSD-menuen
for at justere lydstyrken.

Bl USB-problem

USB-tilsluttet udstyr fungerer ikke

*  Kontrollér, om USB upstream-kablet er
tilsluttet korrekt

*  Sluk for skeermen, og teend den igen. Det kan
vare ngdvendigt at installere/geninstallere
USB-driverne pa din pc og sikre, at hubben er
aktiv.

»  Gentilslut det USB-tilsluttede udstyr

For yderligere hjelp, se venligst Forbruger-
informationscentre-listen og kontakt Philips's
Kundeservice.



7.2 FAQ for SmartControl Premium

SP1.

Sv.:

SP2.

Sv.:

Jeg har udskiftet skeermen pa en pc

til en anden skaerm, og nu fungerer
SmartControl Premium ikke l&ngere. Hvad
skal jeg gore?

Genstart din pc og se, om SmartControl
Premium fungerer nu. Eller skal du afinstallere
og geninstallere SmartControl Premium for
at sikre, at den korrekte driver er installeret.

SmartControl Premium fungerede fint
tidligere, men nu virker programmet ikke
leengere. Hvad skal jeg gore!?

Hvis nogle af de felgende handlinger har
vaeret udfert, skal skeermdriveren maske
geninstalleres.

* Videografikadapter er blevet udskiftet med SP4.

en anden

* Opdater videodriver

o Aktiviteter i OS som f.eks. servicepakke
eller programrettelse

» Opdater Windows og opdater skerm- og/
eller videodriver

* Windows blev startet med skaermens
strem sldet fra eller afbrudt.
For at finde ud af det, skal du klikke
pa "Denne Computer" og derefter pa
Egenskaber -> Hardware ->Enhedsstyrer.
Hvis du ser "Plug & Play skeerm" under
Skeerm, skal du geninstallere. Afinstallér
SmartControl Premium og geninstallér
det.

SP3.

Sv.:

Sv.:

SP5.

Sv.:
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Efter installation af SmartControl Premium
sker der ingenting, selv om jeg klikker pa
fanen SmartControl Premium og venter,
eller der vises en fejlmeddelelse. Hvorfor?

Det skyldes muligvis, at din grafiske adapter
ikke er kompatibel med SmartControl
Premium. Hvis grafikadapteren er en

af ovennaevnte marker, skal du preve

at downloade den mest opdaterede
grafikadapterdriver fra det pageeldende
firmas ? websted. Installer driveren. Afinstallér
SmartControl Premium og geninstallér det
igen.

Huvis det stadig ikke virker, er vi bange for,

at grafikadapteren ikke understgttes. Ga til
Philips websted og kontrollér, om der findes
en nyere driver for SmartControl Premium .

Nér jeg klikker pa "Product Information"
("Produktinformation"), ses kun nogle af
oplysningerne. Hvad er der sket?

Det kan vare, at din grafikkortadapterdriver
ikke er den mest opdaterede version, som
fuldt ud understgtter DCC/CI greenseflade.
Prgv at downloade den mest opdaterede
grafikkortadapterdriver fra det pagezeldende
firmas ? websted. Installer driveren. Afinstallér
SmartControl Premium og geninstallér det
igen.

Jeg har glemt min PIN-kode til Theft
Deterence (Anti-tyveri) funktionen. Hvad
gor jeg!

Philips servicecenter forbeholder sig retten
til at bede om legitimation og godkendelse
for at kunne etablere skaeermens ejer.



SPé.

Sv.:

| en skeerm med Smartlmage-funktion
svarer sRGB-funktionen i farvens
temperaturfunktion i SmartControl
Premium ikke. Hvorfor?

Nar Smart-billede er aktiveret, deaktiveres
sRGB systemet automatisk. For at bruge
sRGB skal du deaktivere Smart-billede med
E] foran pa skeermen.
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7.3 Generelle FAQ

SP1:

Sv.:

SP2:

Sv.:

SP1:Hvad skal jeg gore, hvis skarmen
under installationen viser "Cannot display
this video mode" ("Kan ikke vise denne
videotilstand')?

Den anbefalede oplgsning for Philips 22" er:

1680x1050 @60Hz.

* Frakobl alle kabler og forbind derefter
pc'en til skeermen, som du brugte fon

* | Windows Start Menu, veelg Indstillinger/
Kontrolpanel. | Kontrolpanel vinduet valg
Skeerm-ikonen. | Egenskaber for Skarm
vinduet valg "Indstillinger" fanebladet.
Under indstillinger, skub skyderen til
1680x1050 pixler (22").

+ Abn "Avanceret" og indstil
opdateringshastigheden pa 60Hz og klik
derefter pa OK.

» Genstart computeren og gentag trinene 2

og 3 for at bekreefte, at pc'en er indstillet

pa 1680x1050@60Hz (22").

Luk for computeren, frakobl den gamle

skaeerm og genforbind Philips LCD

skaermen.

Teend for skeermen og derefter for pc'en.

Hvad ger den anbefalede
opdateringshastighed for LCD skarmen?

Den anbefalede opdateringshastighed
for LCD skerme er 60Hz. | tilfeelde af
forstyrrelser pa skeermen skal du seette
den op til 75Hz og se, om dette fierner
forstyrrelserne.

SP3: Hvad er .inf og .icm filerne pa cd-rom'en?

Sv.:

SP4:
Sv.:

SP5:

Sv.:

SPé:

Sv.:
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SP7:

Sv.:

Hvordan installerer jeg driverne (.inf og
.icm)?

Dette er skaeermens driverfiler: Installer
driverne i henhold til brugervejledningens
anvisninger. Computeren kan bede dig om
skeermdrivere (.inf og .icm filer) eller om en
driverdisk, nar du installerer skeermen fgrste
gang. Indszt (medfelgende cd-rom) i pakken
i henhold til anvisningerne. Skeermdrivere (.inf
og .icm filer) installeres automatisk.

Hvordan justerer jeg oplgsningen?

Skaermkortet/grafikdriveren og skaermen
bestemmer sammen oplasningerne til
radighed. Du kan veelge den gnskede
opl@sning "Egenskaber for Skarm" i
Windows® kontrolpanelet.

Hvad, hvis jeg "farer vild", mens jeg justerer
skaermen?

Sa skal du blot trykke pa OK og derefter
valge "Reset" ("Tilbagestil") for at ga tilbage
til de oprindelige fabriksindstillinger:

Er LCD-skermen modstandsdygtig overfor
ridser?

Det anbefales generelt ikke at udsaette
skaeermens overflade for kraftige sted. Den
er beskyttet mod skarpe og stumpe ting.
Nar du handterer skaermen sa pas pa ikke
at trykke for kraftigt pa skeermens overflade.
Det kan pavirke garantibetingelserne.

SP7:Hvordan renger jeg LCD skarmens
overflade?

Til normal renggring skal du blot anvende

en ren, blgd klud. Til kraftigere rengering skal
du bruge isopropylalkohol. Brug ikke andre
oplgsningsmidler sasom ethylalkohol, ethanol,
acetone, hexan osv.



SP8: Kan jeg ®ndre skarmens farveindstilling?

Sv.:

Ja, du kan andre farveindstillingen via OSD

pa felgende made:

* Tryk pa "OK" for at vise OSD (On Screen
Display)-menuen

* Tryk pa "Ned-pil" for at velge indstillingen
"Color" (Farve), og tryk derefter pa "OK"
for at angive farveindstillingen. Der er tre
indstillinger, som vist nedenfor.

1. Color Temperature (Farvetemperatur)
- de seks indstillinger er 5000K, 6500K,
7500K, 8200K, 9300K og 11500K. Med
indstillinger i 5.000K omradet virker
skeermen "varm" med en red-hvid
farvetone, mens en 11.500K temperatur
giver en "kold" bld-hvid toning.

2. sRGB - dette er en standardindstilling,
som sikrer korrekt udveksling af farver
mellem forskellige enheder (f.eks. digitale
kameraer, skeerme printere, skannere
osV.)

3. Brugerdefiner - brugeren kan valge sin
foretrukne farveindstilling ved at indstille
den rede, grenne og bl farve.

© Bemark:

Et mal for farven pa lys, der udstrales fra

et objekt, mens det opvarmes. Dette mal
udtrykkes pd en absolut skala (kelvingrader).
Lavere kelvingrader sdasom 2.004K er rede,
hgjere temperaturer sasom 9.300K er bla.
Neutral temperatur, 6.504K, er hvid.

SP9:  Kan Philips LCD skermen monteres pa

Sv.:

veggen?

Ja. Philips LCD skarme har denne ekstra
egenskab. Standard VESA monteringshullerne
pa bagsiden tillader montering af Philips
skeermen pa de fleste VESA standardarme
og -tilbeherVi anbefaler, at du kontakter

en reprasentant for Philips salgsafdeling for
yderligere oplysninger.
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SP10: Kan jeg forbinde min LCD skaerm til

Sv.:

enhver pc, arbejdsstation eller Mac?

Ja. Alle Philips LCD skaerme er fuldt
kompatible med standard pc'er, Mac'er og
arbejdsstationer. En ledningsadapter kan veere
nedvendig for at kunne forbinde skeermen til
dit Mac-system.Vi anbefaler; at du kontakter
Philips salgsrepreesentant for yderligere
oplysninger.

SP11: Er Philips LCD skarme "Plug & Play"?

Sv.:

Ja, skeermene er "Plug & Play" kompatible
med Windows 7.

SP12: SP12:Hvilken slags bredvinkel-teknologi er

Sv.:

til radighed?

For indeveerende har paneler af typen IPS
det bedste kontrastforhold, sasmmenlignet
med MVA- og PV-teknologierne. TN-panelet
er blevet forbedret gennem drene men
IPS-paneler giver bedre resultater end TN-
paneler.



SP13: Hvad er "billedklabning" eller

Sv.:

"billedindbraending” eller "efterbillede"
eller "spogelsesbillede” pd LCD skarme?

Uafbrudt visning af stille eller statiske billeder
over en lengere periode kan fordrsage,

at det "braendes fast” pa skarmen, dvs. de
sakaldte “spagelsesbilleder” pa din skarm.
"Fastbreending” og "spegelsesbilleder” er
velkendte feenomener inden for LCD-
skeermteknologien. | de fleste tilfeelde
forsvinder "indbreending" eller "efterbillede”
eller "spagelsesbillede" gradvist, efter at
strsmmen er slaet fra.

Serg altid for at aktivere en pauseskaerm, der
bevaeger sig, nar skeermen efterlades uden at
blive anvendt.

Serg altid for at aktivere et program, der
opdaterer skermbilledet regelmaessig, hvis
LCD-skaermen viser indhold, der ikke skifter:

() Advarsel

Alvorlig "indbraending"- eller "efterbillede"- eller
"spogelsesbillede"-symptomer forsvinder ikke
og kan ikke repareres. Ovennavnte skader er
ikke deekket af garantien.

SP14: Hvorfor viser skarmen ikke skarp tekst?

Sv.:

Hvorfor viser den forrevne tegn?

LCD skeermen arbejder bedst med sin native
opl@sning pa 1680x1050@60Hz. Brug denne
opl@sning for at opna det bedste billede.

48



PHILIPS

2010 © Koninklijke Philips Electronics N.V. Alle rettigheder
forbeholdes.

Philips og Philips Shield Emblem er registrerede varemaerker,
tilhgrende Koninklijke Philips Electronics N.V. og bruges under
licens fra Koninklijke Philips Electronics N.V.

Specifikationerne kan aendres uden varsel.

Version: M2226CE1F





